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Configuring Veritas NetBackup 6.5.1 
with VCB 1.1 Proxy Server 

 
This document provides the steps necessary to configure Veritas NetBackup 6.5.1 with 
VMware’s Consolidated Backup Framework. NetBackup 6.5.1 now provides file-level backup 
and restores of Windows virtual machines as well as individual file restore from full virtual 
machine backups. This functionality is built directly into NetBackup 6.5.1 without the need for 
integration scripts.  
 
Note: This is not an official VMware whitepaper or document. This is simply a record of one 
man’s journey to satisfy the quest for knowledge. Please use at your own discretion. 
 
This document assumes the following configuration: 

• VirtualCenter 2.5 

• ESX 3.5 

• VCB 1.1 proxy server 

• Veritas NetBackup 6.5.1 

• Windows Services for Unix 3.5. 

Installing Veritas NetBackup on VCB Proxy Server 
 
Start by downloading and installing VMware Consolidated Backup 1.1 to a Windows 2003 
server. Once you’ve obtained the source files for NetBackup 6.5, proceed with the install 
followed by the NetBackup 6.5.1 Update. 
  

1. Navigate to the above folder and run launch.bat. 

2. Select the NetBackup Installation link from the splash screen. 
3. Now select Install Server Software. 
4. Click Next. 
5. Accept EULA and click Next. 
6. Choose Typical and leave default selection, Install to this computer only. Click Next. 
7. Enter license key, click the NetBackup Master Server. 
8. Accept default Master Server name and click Next. 
9. Accept default for Enterprise Media Master Server and click Next. 
10. Click Install and wait. 
11. Once it’s done, click Finish. 

 



 

Chris C. Skinner Page 2 5/5/2008 

Configuring Veritas NetBackup 6.5.1 
 

1. When the NetBackup Administration Console comes up, cancel out of the wizard 
since setup will be done manually. 

2. Create two new folders such as C:\vmbackups and C:\mnt on the VCB Proxy Server. 
Make sure they are empty. 

3. From within the NetBackup Administration Console, expand Storage and right-click 
the Storage Units object and choose New Storage Unit... 

 
 

4. Enter any name and browse to the C:\vmbackups folder. Check the This directory can 
exist on the root file system or system disk box. Click OK. 
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Setting up the NetBackup Credentials for VMware 
 

1. Expand Media and Device Management, next expand the Credentials option and right-
click Virtual Machine Servers. Choose New… 

2. Enter the fully qualified name of the VirtualCenter server and click Ok. 
3. In the drop down box, select VMware Virtual Center Server. Enter administrative 

credentials and password and click Ok. 
Note: For VCB 1.1 use port 443, VCB 1.0.3 or earlier use port 902. 

 
4. At this point a warning message will be presented stating that the NetBackup service will 

need to be restarted. Click Ok to acknowledge. The services will be restarted later. 
 

 

Adding VCB Proxy Server to NetBackup Host Properties 
 

1. Expand NetBackup Management in the left pane, expand Host Properties and select 
Master Servers.  
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2. Double the VCB Proxy in the right pane, scroll down and select Virtual Machine Proxy 
Servers.  

3. Click the Add button followed by the ellipse button and choose the VCB proxy server 
from the list or enter the FQDN and click Ok. 

4. Click Add and Close. Now click Apply and Ok. 
5. Click Ok to acknowledge the warning again. 

 

Set the Client Host Properties for Timestamps 
When performing physical machine backups, NetBackup can use different methods to 
determine which files have changed since the previous backup. NetBackup can either use the 
archive bit or timestamps. Furthermore, NetBackup can consult the Windows Change 
Journal for incremental backups.  
Since VCB virtual machine backups are always performed on snapshots of virtual machine disk 
images, only timestamp-based backups will work. Therefore, NetBackup must be configured to 
use timestamps and the Change Journal has to be ignored. This can be done by performing the 
following steps:  

1. In the left-hand pane of the NetBackup Administration Console, navigate to 
NetBackup Management/Host Properties/Clients.  

2. This will activate the client button on the menu bar. Click the button to choose the client. 
3. Using the ellipse button, choose the VCB proxy server and click Ok twice. 
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4. In the Client Properties dialog box, expand Windows Client in the left pane and select 
Client Settings. 

5. In the right-hand pane of this window (which is now labeled Client Settings) locate the 
setting Incrementals.  

6. Change the default for this setting from Based on archive bit to Based on timestamps.  
7. Make sure that the Checkbox for Use Change Journal in incrementals is not checked. 

Now click Ok. 
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8. At this point, it might be wise to reboot the VCB proxy server to ensure all the changes 

are reset and the warning message from earlier is addressed. 

Creating a Virtual Machine Backup Job in NetBackup 
 
The next step is to configure NetBackup to schedule periodic backups for specific virtual 
machines. 
 

1. On the VCB Proxy, open the NetBackup Administration Console.  
2. In the left pane, highlight Policies. Right-click, choose New Policy. Enter a name for the 

backup job but do not check the Use Backup Policy Configuration Wizard. Click OK. 
3. On the Attributes tab, click the drop down menu for the Policy type: 

• MS-Windows-NT – Backs up individual drives, folders and/or files for Windows 
guest operating systems. 

• FlashBackup-Windows – Performs full virtual machine backups or individual 
drives for Windows guest operating systems. This method potentially backs up 
faster if virtual machine is heavily populated with small files. 

Configuring a Virtual Machine Backup Policy 
 

1. Select a storage unit. 
2. Deselect Collect disaster recovery information for Bare Metal Restore checkbox. 
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3. Select Perform snapshot backups and select Perform off-host backup, next click Use 
virtual machine proxy option.  

4. Click Snapshot Options. 
 

 
 

5. On the Snapshot Client Options page, click inside the Snapshot mount point 
configuration column and enter the Windows path to the mount directory created earlier, 
c:\mnt. (this must be a local drive, not a network mount point). 
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6. The Virtual Machine Backup parameter can be set as follows: 
o 0-File – Individual folders or files, drives, or all local drives with MS-Windows-NT 

policy. 
o 1-FullVM – entire virtual machine – FlashBackup-Windows policy only, no 

individual file restores. 
o 2-Mapped FullVM – entire virtual machine – FlashBackup-Windows policy only, 

two restore options – entire virtual machine or individual files or folders. 

 
7. Click Ok. 
8. Click the Schedules tab and select New button. Enter name for schedule, the frequency 

and click OK. 

 
 

9. Choose the Clients tab and click New. Select the Browse virtual machines checkbox 
and expand the VirtualCenter server. Click Ok when finished. 
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Note: NetBackup uses DNS lookups to populate this list. Make sure that the virtual 
machine’s FQDNs can be resolved or they are listed in the HOSTS file on the VCB proxy 
server. This populated list is cached in a file on the VCB proxy server in: 

 
 C:\Program Files\Veritas\NetBackup\online_util\fi_cntl\vcbnames_vc-FQDN_Any 

In a few cases, the directory may not have been created during the install. If this is true, 
manually create and recreate the policy. This list may be outdated if new virtual machines 
have been added. Simply click the refresh button to update the list. 
 

 
 

10. Choose the Backup Selections tab and click the New button. NetBackup 6.5.1 uses 
Windows Volume Shadow Copy for Windows 2003 Servers by default. To ensure that it 
can successfully snapshot the virtual machine, make sure that the following has been 
enabled: 
Volume Shadow Copy (VSS) - Windows 2003 Virtual Machines Only 
To increase the cache size when VSS is used on Windows 2003 Server clients: 
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a. In Windows, right-click My Computer and select Manage. 
b. In the console tree, right-click Shared Folders, select All Tasks, and then Configure 

Shadow Copies. 
c. Select the volume on which to make changes, and then click the Settings button. 
d. In the Settings dialog box, change the Maximum Size setting to either No Limit or a 

size large enough to suit the requirements of the installation and usage of VSS. 
Use the table below to configure full backups or file and/or folder backups. Additional 
information is available at http//entsupport.symantec.com/docs/293350 on page17: 

 
Source: Symantec Corporation 

11. In the Netbackup Administration Console, select the new policy, right-click and choose 
Manual Backup. Click OK to start job. 
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12. Once the backup has started, click the Activity Monitor in the left pane monitor the 
backup progress. The little blue man with his arms up in the air indicates success. 

 

 

Restoring a Full Virtual Machine Using NetBackup 
There are a couple of steps to restoring a full virtual machine. First, restoring the NetBackup 
version of the virtual machine’s backup files using the Backup, Archive, and Restore 
application. Next, locate the restored files from the VCB proxy server to the Service Console 
using vcbRestore, VirtualCenter 2.5 Converter utility, or NetBackup’s restore application. 
 

1. Launch the NetBackup  Backup, Archive, and Restore application. 
2. On the menu, choose File > Specify NetBackup Machines and Policy Type… 
3. Specify the following in the drop down list: 

a. Server to use for backups and restores  VCB proxy server. 
b. Source client for restores  the virtual machine to be restored. Click the Edit 

Client List button to manually add the FQDNs of the virtual machines. 
c. Destination client for restores  VCB proxy server. 
d. Policy type for restores  FlashBackup-Windows (see Configuring a Virtual 

Machine Backup Policy for the correct option). 
4. Click Ok. 
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5. On the menu bar, click the down arrow next to Select to restore… button and choose 
the Restore from Virtual Machine Backup option. 

 
6. Select the backup job to restore from date/time list, check the virtual machine and click 

the restore button in the left column. 

 
7. When the Restore Marked Files dialog box opens, there will be two options for restoring: 

a. Restore the entire virtual machine  In the drop down list, select the 
appropriate VirtualCenter server. Choose the VCB proxy server as the staging 
server and enter the path to the c:\Restore directory. This method will restore 
the virtual machine to its original, backed up location using VMware-supplied 
scripts. 
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Note: the virtual machine cannot exist in the VirtualCenter inventory prior to restoration. 

b. Restore all virtual machine files to the staging machine  Select the VCB 
proxy server as the staging machine and: 

i. Run vcbRestore from the ESX Service Console using Windows Services 
for Unix (see below) from C:\restore.  

ii. Using VirtualCenter 2.5, run the import wizard from Converter to restore the 
virtual machine. 

 
8. Then click the Start Restore button to begin. Click Yes to view the progress. Below is a 

successful restore: 
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Restoring a File to a Virtual Machine Using NetBackup 
1. Launch the NetBackup  Backup, Archive, and Restore application. 
2. On the menu, choose File > Specify NetBackup Machines and Policy Type… 
3. Specify the following in the drop down list: 

a. Server to use for backups and restores  VCB proxy server. 
b. Source client for restores  the virtual machine to be restored. Click the Edit 

Client List button to manually add the FQDNs of the virtual machines. 
c. Destination client for restores  VCB proxy server. 
d. Policy type for restores  MS-Windows-NT or FlashBackup-Windows with 

virtual Machine parameter set to either 0-File or 2-Mapped FullVM (see 
Configuring a Virtual Machine Backup Policy for the correct option). 

4. On the menu bar, click the down arrow next to Select to restore… button and choose 
the Restore from Normal Backup… option. 

 
5. Select the backup job to restore from date/time list, check the folder to restore and click 

the restore button in the left column. 
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6. When the Restore Marked Files dialog box opens, choose the appropriate restore 

option and click Start Restore. Click Yes to view the progress if desired. 

 
7. Once the restore is complete, navigate to the c:\restore folder on the VCB proxy 

server and copy it to the correct virtual machine. 

Configuring Windows Services for Unix 3.5 (Optional) 
 
By installing Windows Services for Unix (installed in Windows 2003 R2 by default), 
vcbRestore can be executed from the Service Console directly for restores without needing to 
copy the virtual machine’s backup files manually first. This allows a mount point to be created on 
the Windows Server that can be accessed directly from the Service Console by using the mount 
command. 
 

1. Download Windows Services for Unix 3.5 from the Microsoft web site to a directory 
such as, C:\unixservice on the VCB Proxy Server: 
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http://www.microsoft.com/downloads/details.aspx?FamilyID=896c9688-
601b-44f1-81a4-02878ff11778&DisplayLang=en 
 

2. After the files have finished unzipping, run C:\unixservice\setup.exe. 
3. Accept EULA and all other default settings. When finished, do not reboot server yet. 
4. Change the following Server Service settings by going into Start > Administrative 

Tools > Services: 
 

ONC/RPC Port Mapper      Stopped and Manual 
Server for NFS   Started and Automatic 
User Name Mapping  Started and Automatic 
 
Note: If NFS service won’t start, configure ONC/RPC Port Mapper service as listed 
above and reboot server. 
 

5. Start Services for Unix Administration. 
 

 
 

6. Using WinSCP, copy /etc/passwd and /etc/group from one of the ESX host 
machines managed by the VirtualCenter server to C:\netbackup on the VCB Proxy 
Server. Close WinSCP. 

7. In the Windows Services for Unix application, select User Name Mapping from the list. 
In the right pane, click the Use Password and Group files radio button and browse to 
the folder in which these files reside. 
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8. Next, select the Maps heading and click Simple Maps. Under Advanced Maps, click the 
Show User Maps link. 

 

 
 

9. Click the List Windows Users and List Unix Users buttons and scroll down until 
Administrator and root are selected. Click Apply and close application. 
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10. Create a folder on the VCB Proxy Server called C:\restore. Right-click the folder, 
choose Properties, NFS Sharing. Click Share this folder and then click the 
Permissions button. Check the box Allow root access and click OK twice. 

 

Configuring the ESX host for vcbRestore from Windows NFS 
 
Now that Windows Services for Unix has been installed on the VCB Proxy Server, vcbRestore 
can be run directly from the Service Console without first copying over the backed up files. 
WARNING: This is not officially supported by VMware. Use at your own risk!! 

 
1. From a Putty session, log onto the ESX host as root. Start by opening up the firewall port 

for the NFS Client. Do this through VirtualCenter or Putty. 
 
#esxcfg-firewall –e nfsClient 

 
2. Next, create a mount point to C:\restore on the Windows server. 

 
#mkdir –p /mnt/restore 
#mount –t nfs ipaddress_or_FQDN_of_VCBProxy:/restore /mnt/restore 
 
NOTE: To survive a reboot, modify /etc/fstab. 

 
9. When complete, log onto the Service Console as root and run: 
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#vcbRestore –h IPAddress_or_FQDN_of_VC_or_Host –u username –p 
password –s /mnt/restore 

 
10. The virtual machine will restore into its original VMFS volume location. 

11. Once the restore is complete, make sure to clean out the C:\restore mount point on 
the VCB Proxy Server. 


